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Introduction 

 

Introduction 

 

 

 

indows Vista is a great operating system, with 

looks that really bring it up to date over its 

predecessor – Windows XP. If you are looking to add a 

personal touch to your installation of Vista, this guide 

will help you get started. 

There are thousands of customizations you can apply 

and this guide only scratches the surface. As always, 

I’ve written this book so anyone can pick it up and 

work through it. 

I recommend you begin with the ‘Getting Started’ 

chapter, as this will give you a good foundation for the 

rest of the book. A basic knowledge of Windows Vista 

is required to follow most of the guides; any extra 

understanding will come from the above chapter. 

W 
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Once you have read ‘Getting Started’ chapter, you’re 

ready to explore the rest of the book and personalize 

your machine to match your style. 

I’m sure there’s something here for everyone, so take a 

browse through the contents page and see what strikes 

your interest. 

If you have questions, head to the ‘Contact Me’ section 

at the back of this book and get in touch. 
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2.0 Getting Started 

 

 

 

efore you get started with this book, there are a 

few things you should first consider. In this chapter 

I’ll cover how you can slim down your Vista install, 

which can be a key component of your customization. 

I’ll also get you prepared to back up your system 

before you work with the Windows Registry or the 

Group Policy Editor.  

   There are a few Vista annoyances, which can drive 

you crazy when you are applying many changes to your 

system; the latter half of this chapter will cover editing 

your security settings to help you make changes 

without User Account Control constantly bugging you 

while you try. 

   Enjoy working through this book and remember: 

“More is less” – when you customize your system, don’t 

B 
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look to change every last thing. Make changes that 

look good and keep your system clean and tidy. 

 

 

2.1 Slimming down Your Vista Install 

If you are new to using Vista, or if you want to begin a 

clean slate, you may want to cut out some of the bulk 

that comes with Vista. A popular program designed to 

help you with this task is named vLite.  

vLite requires you to copy the setup files from your 

Vista installation disc to your hard drive. You then 

select the components you want to include in your 

install and then you make a bootable ISO file.  

Details of which components you remove come down 

to your choice and are out of the scope of this book. 

However, there are many sites out there that are willing 

to give you a starter point and suggestions. 

While vLite is aimed at more advanced users, you 

should have no problems having a go yourself. In the 

worst scenario, you are left with a Vista installation 

that doesn’t have all the components you need.  

One tip I will urge you to follow is to create the vLite 

ISO on a computer other than the one you are putting 

Vista on. If your OS is not functional you can at least 

try again. 

http://www.vlite.net/download.html
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2.2 Utilizing the Backup and Restore 

Center 

The Backup and Restore center – bundled with 

Windows Vista – is an excellent tool, which allows you 

to backup and restore your files or an image of your 

operating system. 

 

2.2.1 Launching the Backup and Restore Center 

To launch the Backup and Restore Center, do the 

following: 

1. Press the Start buttom 

2. Type Backup 

3. Select Backup and Restore Center 

 

2.2.2 Backing up Your Files 

To backup your files, click Backup Files and follow the 

directions given to you. Select the directories and files 

you want to backup and find a suitable place to store 
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these files. I recommend an external hard drive or 

DVD(s).  

 

2.2.3 Restoring Your Files 

Launch the Backup and Restore center and click 

Restore Files. Locate the medium your files are stored 

on and follow the instructions to get your previously 

backed up files back. 

 

 

2.3 Working with the Windows Registry 

Throughout this book you will need to access the 

Windows Registry and make changes. I try to make 

executable registry hacks in most cases, but it can be 

fun to script your own registry files. Before doing 

anything with the Windows Registry, you should know 

what the registry is, how to back it up, how to restore 

it to a previous state, and how to add keys and values. 

 

2.3.1 What is the Windows Registry? 
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Think of the Windows registry as a control center for 

your computer. Windows settings, individual program 

settings, and other important configuration 

information are stored here. 

 

2.3.2 Accessing the Windows Registry Editor 

To access the Windows Registry, press the start button, 

type regedit, and press Enter. 

When the registry loads, you will be presented with the 

Windows Registry Editor. The registry is made up of the 

following components: 

 Keys 

 Subkeys 

 Values 

 

2.3.3 Adding Keys or Values 

In some of the tutorials in this book, you will need to 

create a new key or value. 

 

2.3.3.1 Adding a New Key 

To add a new key, do the following: 

1. Right click on the parent key 

 



11 | V I S T A  C U S T O M I Z A T I O N  M A N U A L  

Getting Started 

2. Select New > Key 

 

3. Follow the guide’s instructions for what key 

name to assign 

 

2.3.3.2 Adding a New Value 

To add a new value, do the following: 

1. Navigate to the key that you want to add a value 

to 

 

2. Right click in the blank space of the right pane  

 

3. Select New > xx (Where xx is the value specified 

in the guide) 

 

4. Follow the guide’s instructions for what value to 

assign 

 

 

2.4 Backing up and Restoring the Registry  

Some guides in this book will require you to change 

values in your registry. If you make a mistake and 

don’t correct it, you may find your computer is not as 

functional as it was before. To protect yourself from 
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any mistakes, you need to backup your registry. To 

back up and restore your registry, you can use system 

restore or the registry editor. 

 

2.4.1 Backing up and Restoring the Windows 

Registry using System Restore 

You may back up or restore the entire registry using 

system restore, which takes an image of your 

computer in its current (stable) state. This image can 

then be used to restore order to your computer if 

something goes wrong. 

 

2.4.1.1 Backing up the Entire Registry with System 

Restore 

1. Click Start type systempropertiesprotection in 

the Start Search box, and then press ENTER. 

If you are prompted for an administrator 

password or for a confirmation, type the 

password, or click Continue 

 

2. Wait for Windows to search for available disks 

and most recent restore points. In the System 

Properties dialog box, on the System 

Protection tab, click Create 
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3. Type a name for the restore point and then click 

Create 

 

4. After the restore point has been created 

successfully, click OK two times 

 

Note: If System Restore is turned off, click to select 

the local disk, click Apply and then click Create. 

 

2.4.1.2 Restoring the Entire Registry using System 

Restore 

1. Click Start, type systempropertiesprotection in 

the Start Search box, and then press ENTER 

If you are prompted for an administrator 

password or for a confirmation, type the 

password, or click Continue 

 

2. In the System Properties dialog box, on the 

System Protection tab, click System Restore 

 

3. In the System Restore dialog box select Choose 

a different restore point, and then click Next 

 

4. Select the restore point that you want to use, and 

then click Next 

 

5. Confirm your restore point, and then click Finish 

System restore - this restores the selected 

Windows Vista configuration and then restarts 

the computer 
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6. Log on to the computer. When the System 

Restore confirmation page appears, click OK.. 

 

2.4.2 Backing up and Restoring the Windows 

Registry using the Registry Editor 

You may back up or restore the entire registry using 

the registry editor, which saves a file on your hard 

drive (or any media.) This file can then be restored at 

any time if you make a mistake. 

 

2.4.2.1 Backing up the Entire Registry Using the 

Registry Editor 

To back up the entire registry using the registry editor, 

do the following. 

1. Press Start > Run (Winkey+R) and type regedit 

2. Left click Computer in the left pane 

3. Go to File > Export 

4. Save the file (for extra caution, save the file to a 

USB thumb drive) 
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2.4.2.2 Restoring the Entire Registry Using the 

Registry Editor 

To restore the entire registry using the Registry Editor, 

do the following: 

1. Press Start > Run (Winkey+R) and type regedit 

2. Left click Computer in the left pane 

3. Go to File > Import 

4. Choose the backup file you created 

 

2.4.3 Backing up and Restoring Individual Registry 

Entries using the Registry Editor 

You may back up or restore individual registry entries 

using the registry editor, which saves a file on your 

hard drive (or any media.) This file can then be 

restored at any time if you make a mistake. 

 

2.4.3.1 Backing up a Single Key 

1. Find the key you want to back up and right click 

on it 
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2. Click Export 

 

3. Save the file somewhere safe with a distinctive 

name 

 

2.4.3.2 Restoring a Single Key 

1. Find the key that you previously saved 

 

2. Double click on the file and select Yes 

 

 

2.5 Get a Windows Vista Recovery Disc 

Most new computers these days come with windows 

Vista installed. Most of these computers don’t come 

with any kind of Windows Vista disc. Some may come 

with a recovery disc but they are bad news as most 

recovery disks will delete all your files and restore your 

computer to the state it was in when you first 

purchased it. 

Windows Vista DVD’s come with a recovery center to 

allow you to fix operating system related problems. If 

you do not have this DVD, Microsoft made a recovery 

disc for this purpose. 

Please Note: This disc cannot be used to install or 

reinstall Windows Vista. 
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Download Windows Vista Recovery Disc (from 

NeoSmart technologies) (120 MiB) 

Or Download Windows Vista Recovery Disc Torrent 

Learn how to burn an ISO image to a DVD 

 

 

2.6 Adding “Take Ownership” Context 

Menu 

Many folders in Vista are protected from changes and 

require administrative approval to change every time. 

Sometimes this can become tedious, so I’ve created a 

registry hack you can use to take ownership of select 

files. 

1. Download TakeOwnership.zip 

 

2. Add “Take ownership” to your context menu by 

merging (double click) InstallTakeOwnership.reg 

into your windows registry 

Remove “Take ownership” from your context menu by 

merging RemoveTakeOwnership.reg into your registry. 

 

 

 

http://coblitz.codeen.org/neosmart.net/downloads/guides/Vista_Repair/Vista_Recovery_Disc_x86.iso
http://neosmart.net:6969/torrent.html?info_hash=c7411cffb5b0c27b28d0ec080af55ea0016f7b7b
http://neosmart.net/wiki/display/G/Burning+ISO+Images+to+a+CD+or+DVD
http://mintywhite.com/images/techtips/0804/10takeowner/TakeOwnership.zip
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2.7 Stop UAC Blacking Out the Screen 

Have you noticed that when Windows Vista prompts 

you to allow a program to take action, that the screen 

blacks out? This is to show you that you are moving to 

an elevated desktop - where you will allow the program 

to continue. This can be annoying but you can disable 

this feature. 

1. Download DisableUACBlackout.zip 

 

2. Extract the archive  

 

3. Double click on DisableUACBlackout.reg  

To re-enable the blackout, double click on 

ReEnableUACBlackout.reg 

 

 

2.8 Disabling User Account Control 

If you feel confident with taking control of security, you 

probably don’t need the User Account Control (UAC) 

altogether. To disable UAC, do the following: 

1. Open the Start Menu and select Control Panel 

 

2. Select User Accounts 

 

3. Select Turn User Account Control on or off 

 

http://mintywhite.com/images/techtips/0803/16uacblackout/DisableUACBlackout.zip
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4. Uncheck the box next to “Use User Account 

Control (UAC)…” and press OK 

You will now be asked to restart your computer to 

activate your changes. After your computer is restarted 

you won’t be bothered anymore by the UAC. 

To re-enable UAC, repeat the above process and at 

step 4 recheck the box next to “Use User Account 

Control (UAC)…” and press OK. 
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3.0 Cleaning up Your 

Computer 

 

 

 

ust like any car, Windows needs to be maintained 

and cleaned frequently. Whenever I work on 

someone’s computer, I have a check list of things I like 

to do to ensure I won’t be working on the same 

computer anytime soon. 

Anyone can maintain their computer; they just have to 

learn how. In this chapter you’ll learn some basic tips 

and about some tools to use – to ensure your 

computer becomes/remains clutter free and does not 

get sluggish. 

 

 

 

J 
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3.1 Automatically Delete Temporary Files 

The Windows Disk Cleanup Wizard will delete your 

temporary files, but only if they are over a week old. To 

create a simple batch script that will clean up your 

temporary directories, do the following: 

 

3.1.1 Creating the Batch File 

1. Open Notepad and type the following: 

 

cd C:\Users\%username%\AppData\Local 

rmdir /S /Q Temp 

2. Save the file as cleantemp.bat 

 

3. Now double click on the file to remove your 

temporary files and free up space on your 

computer. 

If this doesn’t work and gives an access error, try 

replacing %username% with you windows login 

username. 

 

3.1.2 Automating the Process 

To automate this process, so you do not need to 

remember to run it, do the following:  
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1. Right click on the batch file and select create 

shortcut 

  

2. Place the shortcut in your startup folder in the 

start menu.  

Now when you log in to Windows Vista, your temporary files 

will be deleted. 

 

 

3.2 Cleaning up Windows 

Cleaning up Windows can be a tedious task as there 

are so many temporary and unused files stored 

everywhere. Manual cleaning may be more thorough, 

but would take hours. Luckily there are two programs 

suited to this job.  

The first of these two programs is the well known 

CCleaner. CCleaner is a freeware system optimization, 

privacy and cleaning tool. It removes unused files from 

your system - allowing Windows to run faster and 

freeing up valuable hard disk space. It also cleans 

traces of your online activities such as your Internet 

history. Additionally it contains a fully featured registry 

cleaner. 

Another program I use frequently is Advanced Windows 

Care (AWC.) AWC is a comprehensive PC-care utility 

that has a one-click approach to helping protect, repair 

and optimize your PC.  

http://www.ccleaner.com/download
http://www.iobit.com/advancedwindowscareper.htm
http://www.iobit.com/advancedwindowscareper.htm
http://www.iobit.com/advancedwindowscareper.htm
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Personally I prefer AWC, but CCleaner is great too. You do 

not need both of these programs; one of these programs 

should take care of keeping your computer free of 

temporary clutter. 

 

 

3.3 Disable and Delete the Hibernation 

File 

Windows places a file on your hard drive that stores 

your current data when your computer goes into 

hibernation. If you do not use hibernation, you can 

delete these files and save as much space as you have 

RAM (i.e. 512mb or 2gb etc.) In this guide you will 

learn how to disable hibernation and remove the old 

hibernation file. 

 

3.3.1 Disable Hibernation 

1. Click Start, All Programs, and then right click on 

Command Prompt. (Or type CMD into the start 

menu search box.) 

 

2. Select Run as administrator. 

 

3. If User Account Control prompts you to allow the 

action, click on Continue. 
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4. In the command prompt window, type “powercfg 

–h off” (without the quotes). 

 

5. Close the Command Prompt window. 

 

3.3.2 Delete the Hibernation File 

1. Click Start, All Programs, Accessories, System 

Tools, and then click Disk Cleanup. (Or type Disk 

Cleanup into the start menu search box and hit 

enter.) 

 

2. If prompted to choose a drive, select the drive in 

which Windows XP/Vista is installed on to and 

press OK. 

 

3. Disk Cleanup will scan the hard drive and 

present you with a list of options. 

 

4. Check Hibernation File Cleaner, and then click 

OK. 

 

5. When asked “Are you sure you want to 

permanently delete these files?” click on the 

Delete Files button. 
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3.4 Reclaim Disk Space after SP1 Install 

When you install Vista SP1, a backup of all replaced 

files is made. This is done so you can roll back to pre-

SP1 if you desire. SP1 has been out for some time now 

and many of you will no doubt be satisfied with using 

it. In this guide, you will learn how to reclaim disk 

space taken up by the Vista SP1 install. 

By following this guide, you will be able to save 600-

800 MB of disk space. 

Please note: After running this tool, you cannot 

uninstall Vista SP1. 

1. Press WINKEY+R 

 

2. Type vsp1cln.exe and hit enter 

 

3. When prompted, type Y and hit enter 

 

4. After a few seconds, you will have your hard disk 

space back 

 

 

3.5 Remove Entries from Add/Remove 

Programs 

There may be several reasons for removing certain 

programs from the add/remove programs list. One 

reason may be that you have no intention of removing 
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some programs and they are cluttering the list - or you 

may want to remove that net monitoring program so 

your kids can’t remove it. In this guide you will learn 

how to remove these programs. 

I recommend you backup your registry before doing 

this; however, if you follow these instructions, you will 

be fine. 

1. Press the windows key and R 

2. Type in regedit 

3. Now you will see the registry editor. 

4. Go to the following entry: 

HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\

CurrentVersion\Uninstall 

5. In the left pane are the programs (some represented 

by numbers and letters, and some by their name) and 

in the right pane you can see the display name. 

6. Find the key that corresponds to the program you 

want to hide. Select the key in the left pane and click 

File > Export 

7. Choose a name for the file and save it. (This will 

allow you to restore the key when you want to uninstall 

the program.) 

8. Now the key is backed up, you can delete the key by 

right clicking on it and choosing Delete 
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3.6 Scan Your Drive for Duplicate Files 

Do you have thousands of photos, documents, songs 

etc on your hard drive? If you do, you’ll likely have 

duplicates all over the place. In this guide you’ll learn 

how to search for duplicates and delete them; thus, 

saving you space and keeping you organized. 

Download Easy Duplicate Finder 

 

3.6.1 Easy Duplicate Finder Features 

 Search for true duplicates (files with same 

contents) 

 

 Powerful search engine with fast files check 

 

 Full binary (byte-by-byte) comparison  

 

 Flexible Scan settings 

 

 Search files by masks 

 

 Size conditions & skip zero-length files option  

 

 Find duplicates from selected folders or drives 

 

 Add multiple folders/drives for scanning  

 

 Protect system files and folders 

 

http://www.easyduplicatefinder.com/download.html
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 Move files to Recycle Bin or delete duplicate files 

permanently 

 

 Mark selected duplicates by renaming them with 

adding prefix to file names - to test which files is 

safe to delete  

 

 Much more… 

 

3.6.2 Easy Duplicate Finder System Requirements 

 OS: Windows 95/98/Me/2000/XP/Vista  

 

 CPU: 400 MHz or higher  

 

 RAM: 128 MB or more  

 

 Hard Drive: 5 MB of free space  

 

 

3.7 Remove Unwanted Software 

I advise you to browse your add/remove programs list 

and weed out any software you do not use and is 

clearly taking up space. 

If you have a newer PC, there may be a lot of trial 

software, coined “bloatware”. The PC Decrapifier is 

designed to remove a specific list unwanted software 

in an unattended fashion. The PC does not need to be 

http://www.pcdecrapifier.com/download
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new; however, the older the PC is, the less likely it will 

have any of the software it can detect. 

Simply download the file above, and run the EXE. There 

is no installer necessary. If you have anti-virus software 

installed, it may complain about this program because 

it is written with a scripting language. These warnings 

can be safely ignored. 

When it runs, you will be presented with a wizard style 

dialog box that steps you through the entire process. 

You will be able to pick and choose what you want to 

remove. 

It will not begin removing anything, without prompting 

you first! 

Hit the “Next” button and it will begin cleaning your PC. 

If it does not find anything, a pop-up box will notify 

you of this and the program will exit and not modify 

your PC. 

 

 

 

3.8 Disable Memory Dump Files and Save 

HDD Space 

If your computer crashes it will create a dump file. 

From this dump file you can diagnose the source of the 

problem. It is unlikely you will need this file; if you do, 
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you can always turn the option back on. This guide will 

show you how to save space by disabling memory 

dump files in Vista. 

1. Press Start and click Control Panel 

 

2. Type Advanced in the search box 

 

3. Click on View advanced system settings in the 

search results 

 

4. Under Startup and Recovery, click Settings 

 

5. In the Write debugging information drop down, 

click (none) and press OK 

You will now save space and not store useless 

information. 
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4.0 Changing Your Boot and 

Login Screens 

 

 

 

he first thing you see as you boot up your 

computer is your boot screen and shortly after 

you’ll come to your login screen (if you have login 

enabled.) Although you don’t spend much time using 

these interfaces, customizing them can be a nice 

touch. In this chapter you’ll learn how to customize 

both these screens.  

   To successfully achieve this in an easy manner, you’ll 

need two tools: ‘Vista Boot Logo Generator’ and 

‘LogonStudio Vista’. Both of these programs do not need to 

run in the background, so the performance of your system 

does not deteriorate at all. These programs simply patch 

your system files, so you don’t have to do any shell 

scripting or editing of system files. Add a personal touch to 

your system as you follow this chapter. 

T 
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4.1 Enable the Aurora Boot Screen 

The boot screen in Windows Vista is plain and lame. To 

change the boot screen, follow these simple steps: 

1. Press the Start button, type ‘msconfig’, and hit 

enter 

 

2. If prompted, select Continue  

 

3. The System Configuration window will come up. 

Click on the Boot tab 

 

4. Select your Windows Vista installation 

 

5. Check the ‘No GUI boot’ box 

 

6. Press OK 

 

7. Click on Restart 

Your computer will now reboot, and you will see the 

Aurora boot screen. 

 

 

4.2 Making a Custom Boot Screen 

You can easily make your own boot screen for Windows 

Vista by following this guide: (Please note: this does 

not work for SP1… yet) 
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1. Navigate to C:\Windows\System32\en-US 

 

2. Locate ‘winload.exe.mui’ and take ownership of 

the file (see chapter 2) 

 

3. Rename the file to ‘winload.exe.mui.old’ 

 

4. Press the Start button, type ‘msconfig’, and hit 

enter 

 

5. On the ‘Boot’ tab, check ‘No GUI Boot’ 

 

6. Press OK and when prompted to restart, select 

‘Exit without restart’ 

 

7. Download Vista Boot Logo Generator 

 

8. Install the software on to your machine 

 

9. Open Vista Boot Logo Generator 

 

10. Select your boot screen (you’ll need both  

800x600 and 1024x768 24-bit BMP files) 

 

11. Select ‘File > Save Boot Screen File As…’ and save 

your new ‘winload.exe.mui’ file in 

C:\Windows\System32\en-US 

 

Restart your computer to verify your boot screen 

works. 

 

 

http://www.computa.co.uk/staff/dan/?p=18
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4.3 Customize Your Logon Screen 

Logon Studio, created by the Stardock team lets you 

customize your Windows Vista logon screen. Choose 

from many styles that will make your computer stand 

out from the crowd. 

Logon Studio is freeware, which can set any wallpaper 

as your logon screen. All you need to do is to 

download this utility and choose the wallpaper you 

want to use. 

Logon studio lets you create custom screens within the 

program. Once you apply the screen, Logon Studio 

locks your computer so you can test drive the screen to 

see if it works for you. 

 

 

4.4 How to Use Logon Studio 

Logon Studio is simple to use, but in this guide, I’ll 

show you the basics. To change your login screen, do 

the following: 

1. Open Logon Studio 

2. In the left-hand menu, click ‘Create’ 

3. Browse for your background image and then select 

‘Save’ 

4. Now click ‘Apply’ to test your login screen 

http://www.stardock.com/products/logonstudio/
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4.5 Use Windows Wallpapers for Your 

Logon Screen 

You already have a collection of wallpapers that come with 

Windows. You may use any one of the wallpapers from the 

collection as your boot screen and I’ll show you how to 

achieve this easily. 

1. Install login studio (if you haven’t already) 

2. Download this zip file 

3. Extract the .logonvista files to your desktop 

4. Drag and drop the .logonvista files on to the 

LogonStudio Vista window 

The new logon screens will appear on the right-hand side, 

under "Built-in logon screens". You can now delete the 

.logonvista files. 

http://www.stardock.com/products/logonstudio/
http://www.wincustomize.com/skins.aspx?skinid=2119&libid=65
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5.0 Customizing Your Start 

Menu and Desktop 

 

 

he start menu and your desktop are two of the 

most commonly used elements of Windows Vista. 

Customizing both of them can make your computing 

experience more enjoyable and productive. In this 

chapter, you‟ll learn how to customize and improve 

your start menu; you‟ll also learn how to customize 

your taskbar, system tray, desktop icons, color 

scheme, and mouse cursors.  

   When you are done customizing, you‟ll learn how to 

save your configuration as a theme. Remember, more 

is less with customization, so you don‟t need to follow 

this chapter completely. Use this chapter to inspire you 

to add the finishing touches to your system. 

 

 

T 
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5.1 Customizing Your Start Menu 

The Windows Start Menu is notoriously bloated. There 

are a couple of ways you can customize your start 

menu to restore order. The first is to customize the 

right-hand panel and the second is to organize the 

programs folder. 

 

5.1.1 Customizing the Right-hand Panel 

1. Right click on the Windows button and select 

Properties 

 

2. Click the Customize… button 

 

3. Here you can change what shows up in the right 

section of the start menu. If you don‟t use your 

Music folder, then why have it linked there? 

 

5.1.2 Customizing the Programs List 

After installing a few programs, your start menu can 

get cluttered. To reduce the number of folders in the 

left part of the menu, consider using folders like 

„Media‟, „Internet‟ etc. To customize your Start Menu, 

do the following. 

1. Click the Start Menu button 

 

2. Click on Programs 
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3. Right click on a folder and select Explore All  

Users/Explore 

 

4. Once in the windows explorer window, you can 

rename folders and put links together. I usually 

delete the shortcuts to readme files, help files, 

and uninstall links as these can all be accessed 

from other places, and I rarely use them. 

 

 

5.2 Adding Widgets to Your Start Menu 

Start++ is an enhancement for the Start Menu in 

Windows Vista. It also extends the Run box and the 

command-line with customizable commands.  For 

example, typing "w Windows Vista" will take you to the 

Windows Vista page on Wikipedia! 

Advanced functions can work with search results, 

powered by Windows Vista's integrated desktop search 

engine. For example, typing "play radiohead" will find 

all music that matches the query "radiohead", compile 

the results into an .M3U file, and launch it in Windows 

Media Player. 

Download Start ++ 

 

 

http://brandontools.com/content/StartPlusPlus.aspx
http://brandontools.com/content/StartPlusPlus.aspx
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5.3 Search Google and More from the 

Start Menu 

If you use Google, Wikipedia, Yahoo, etc a lot then this 

guide is for you. In this guide, you‟ll learn how to 

search these websites from your Start Menu. 

Please Note: This guide involves the use of the Group 

Policy Editor, which is not included with Vista Home 

Premium/Basic or Windows XP Home.  

 

5.3.1 Configuring Your Start Menu to Search Google 

1. Start Group Policy Editor (Start > Run > 

“gpedit.msc”) 

 

2. In the left panel, go to User Configuration > 

Administrative Templates >Windows 

Components > Instant Search 

 

3. In the right panel, right click on Custom Instant 

Search Internet Search Provider policy setting 

and select Properties 

 

4. Select Enabled 

 

5. Now in the first String or dll resource… field, 

type Search Google 

 

6. In the The URL to use when… field, type 

http://www.google.com/search?q=%w 
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7. Press OK and Reboot your computer(If you wish 

to apply the changed policy setting immediately, 

open a command prompt and run 

gpupdate/force) 

 

8. Press the Start button, type your search for 

Google, click Search Google, and Google will 

load 

 

5.3.2 Configuring Your Start Menu to Search 

Wikipedia 

Follow the steps above and replace steps 5 & 6 with 

the following: 

5. Now in the first String or dll resource… field, type 

Search Wikipedia 

6. In the The URL to use when… field, type 

http://en.wikipedia.org/wiki/%w 

 

5.3.3 Configuring Your Start Menu to Search Yahoo 

Follow the steps above and replace steps 5 & 6 with 

the following: 

5. Now in the first String or dll resource… field, type 

Search Yahoo 

6. In the The URL to use when… field, type 

http://search.yahoo.com/search?p=%w  

http://search.yahoo.com/search?p=%25w
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5.4 Choosing a Color Scheme 

In Vista, you can easily change the color scheme of 

your desktop. Unfortunately, not all computer systems 

support the Windows Aero color scheme and you will 

need to be using Windows Vista Home Premium, 

Business, or Ultimate to enable Aero.  

To change the color scheme, do the following:  

1. Press the Start button 

2. Select „Control Panel‟ 

3. Under the „Appearance and Personalization‟ 

section, select „Customize Colors‟ 

4. Select the color scheme you want 

5. Press „OK‟ 

You can now enjoy your more personalized colors. 

 

 

5.5 Customizing the Taskbar 

The Windows Taskbar can be customized to meet your 

needs. You can resize the taskbar, hide it, and even 

add toolbars to it. 
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5.5.1 Moving the Taskbar 

By default, the taskbar resides at the bottom of your 

screen. You can move the taskbar to any side of the 

screen or even to another screen if you use more than 

one monitor. To move the taskbar, do the following: 

1. Right click the taskbar and ensure 'Lock the 

Taskbar' is unchecked 

2. Point to a blank spot on the taskbar and drag the 

taskbar to the side of the Desktop where you 

want it 

 

5.5.2 Resizing the Taskbar 

By default, the taskbar is one 'row' wide. You can resize 

the taskbar to any size you want. To resize the taskbar, 

do the following: 

1. Right click the taskbar and ensure 'Lock the 

Taskbar' is unchecked 

2. Place the mouse pointer on the outer edge of the 

taskbar until the pointer turns into a two-headed 

arrow 

3. Drag the border to change the size of the 

taskbar 
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5.5.3 Controlling Taskbar Grouping 

Grouping common items on the taskbar can reduce 

clutter. If you have five instances of internet explorer 

running, the grouping option will display them as one 

button the taskbar. Clicking the internet explorer 

button will bring up a list of all active Internet Explorer 

windows.  

 

5.5.3.1 Disabling Grouping 

Grouping isn't for everyone (including me). To disable 

grouping, do the following: 

1. Right-click the Start button 

2. Select „Properties‟ 

3. Select the „Taskbar‟ pane in the „Taskbar And 

Start Menu‟ 

4. Uncheck the „Group Similar Taskbar Buttons‟ 

checkbox 

 

5.5.3.2 Setting Grouping Limitations 

To change the number of similar windows that need to 

be open to 'kick in' grouping, do the following: 
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1. Press the Start button 

2. Type in regedit and hit enter 

3. Navigate to 

HKCU\Software\Microsoft\Windows\CurrentVersi

on\Explorer\Advanced   

4. Create a new DWORD value named 

TaskbarGroupSize  

In the value field, specify the minimum number of 

similar windows that need to be open to enable 

grouping. A setting of 2 groups related items as soon 

as you open a second window, even if there‟s plenty of 

room on the taskbar; 3 enables grouping as soon as 

you have three or more similar windows; and so on. 

Now log off and log back in to put your new settings 

into effect. 

 

5.5.4 Auto-hiding the Taskbar 

You may find the taskbar gets in the way when you are 

using a program, or even when you are on your 

desktop. You can auto-hide the taskbar in two different 

ways. The first way is to have the taskbar auto-hide 

when it is not in focus. The other way is to have the 

taskbar in the background when you maximize a 

window or move a window over it. 
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5.5.4.1 Auto-hiding the Taskbar All the Time 

To autohide the taskbar, do the following: 

1. Press the Start button 

2. Type taskb in the Search box 

3. click „Taskbar And Start Menu‟ 

The Taskbar and Start Menu Properties dialog box will 

now display. 

4. Check 'Auto-Hide The Taskbar' 

 

To access the taskbar, simply move your mouse to the 

side of the screen the taskbar is located on and it will 

appear. 

 

5.5.4.2 Hiding the Taskbar Behind Active Windows 

To hide the taskbar behind active windows, do the 

following: 

1. Press the Start button 

2. Type taskb in the Search box 

3. click „Taskbar And Start Menu‟ 

The Taskbar and Start Menu Properties dialog box will 

now display. 
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4. Uncheck 'Keep The Taskbar On Top Of Other 

Windows' 

 

 

5.6 Customizing Desktop Icons 

There are many ways you can customize your desktop 

icons: you can resize them, change them, or even 

remove them. Learn how to customize your icons in 

this guide. To customize your icons, do the following: 

1. Right click the desktop and select Personalize 

2. Click Change Desktop Icons 

Here you can select the icons you want to be shown on 

the Desktop.  

You can also change the appearance of an icon by 

selecting it, and clicking 'Change Icon'. In the Change 

Icon dialog box that appears, click the image you want 

to replace that of the selected icon and press OK. 

To change the size, order, and alignment of your 

desktop icons, right click a blank spot on the Desktop, 

select view, and specify the size and alignment of the 

icons or whether you want the icons to be shown on 

the Desktop or hidden. 
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You may also resize the icon size on the desktop by 

clicking a blank area on the desktop, holding the CTRL 

key, and scrolling your mouse wheel. 

 

 

5.7 Changing Your Account Picture 

Your account picture is used for the login screen, your 

start menu, windows meeting space, and more. When 

you first set up your account, you may select one of 

the default images. In this guide you'll learn how to 

customize your account picture. Do this by following 

these steps: 

1. Press the Start button 

2. Click your account picture at the top of the menu 

3. In the User Accounts window, choose 'Change 

Your Picture' 

a. Either click a picture you want to use 

b. OR click Browse For More Pictures, locate 

your picture, and click Open 

If you see any white space around your picture, edit it 

in paint or another editing program to make your 

image square. 
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5.8 Customizing Your Mouse 

You're probably pretty happy with how your mouse 

works, but you can always make some changes, which 

may help you out. I always turn the sensitivity of my 

mouse pad up the maximum, which makes me move 

my fingers less to get around the screen. If I want 

precision, I am unlikely to get it with a laptop mouse 

pad anyway, so I plug in an external one, or use the 

desktop. Learn how to customize your mouse in this 

guide. 

 

5.8.1 Setting the Mouse Buttons 

To change the behavior of your mouse buttons, do the 

following: 

1. Press the Start button 

2. Type mouse in the Search box 

3. Click „Mouse‟ to display the Mouse Properties 

dialog box 

On the Buttons tab, you can switch the mouse for left 

or right-handed use 

Move the slider to set the speed at which you need to 

double-click for Windows to recognize your double 

click. 

When you finish customizing, press the OK button. 
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5.8.2 Setting Mouse Pointer Options 

To change your mouse pointer options, do the 

following: 

1. Press the Start button 

2. Type mouse in the Search box 

3. Click „Mouse‟ to display the Mouse Properties 

dialog box 

4. Click the Pointer Options tab 

Here you may set or change the following options: 

 The speed at which your mouse pointer moves. 

(As you move the slider, you can test the effect 

of the change by moving your mouse.) 

 Increase the precision of the pointer when you 

move short distances 

 Configure the mouse to automatically move to 

the default button in a dialog box to facilitate 

quick selection of the button 

 Set the length of the trails if you want to increase 

the mouse pointer's visibility by temporarily 

showing its path 

 Remove the mouse pointer's visibility when 

you're typing and not using the mouse 
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 Locate the mouse pointer on your screen by 

pressing the CTRL key 

 

 

5.9 Enabling Vista Aero Mouse Cursors 

Can‟t use Vista Aero because it melts your computer? 

Well you can still use the cursors. To enable the Vista 

Aero cursors, follow these simple steps: 

1. Right click on your desktop and select 

Personalize 

 

2. Click on the Mouse Pointers item to select a 

different mouse cursor scheme 

 

3. Change the Scheme from None to Windows Aero 

 

4. Click OK  

Now you have the Aero cursors working for you. 

 

 

5.10 Adding a Mac-like Dock to Your 

Desktop 

Although OS X doesn‟t suit my computing needs, I do 

love the look of some of the features it has. One of the 



55 | V I S T A  C U S T O M I Z A T I O N  M A N U A L  

Start Menu & Desktop 

best features is the easy-to-use and customizable dock. 

You can put a dock in Windows Vista too. To install a 

dock, do the following: 

1. Download ObjectDock here (Go to the page and 

click the “Free Download” button.)  

 

2. Install ObjectDock on to your computer.  

 

3. Once installed, launch ObjectDock (if it hasn‟t 

already).  

You can get thousands of icons for your dock here. 

ObjectDock is very easy to use and there is a lot of 

support out there for this free product; go to the 

ObjectDock website and click “Forums”. 

 

 

5.11 Removing Icons from the System 

Tray 

After using your computer for some time, you may find 

that there are a lot of icons building up in your system 

tray. With Windows Vista, you can hide these icons to 

remove clutter. This guide will show you how to do 

this. 

 

http://www.stardock.com/products/objectdock/
http://mintywhite.com/tech/icons/
http://www.stardock.com/products/objectdock/
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1. Right click the space next to the clock and select 

properties 

 

2. In Taskbar and Start Menu Properties, select the 

Notification Area tab and then select customize 

 

3. Now select the icons you want to hide and 

choose hide 

 

4. Press OK on both windows you just opened and 

you are done 

 

 

5.12 Adding Extra Clocks 

Ever wanted to see, at a glance, what time it is in say… 

London or even Nuku‟alofa? With Windows Vista you 

can. This guide will show you how to add up to two 

extra clocks with Windows Vista without adding any 

extra software. 

1. Click the clock… 

 

2. Click on “Change date and time settings…”  

 

3. Click the “Additional Clocks” tab 

 

4. Check the “Show this clock” button 

 

5. Select the time zone you want to see a clock for 
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6. Give the clock a name 

 

7. Press “OK“  

Now you can see, at a glance, the time around the 

world. 

 

 

5.13 Replacing Outdated System Icons 

Vize is a GUI enhancer for Windows Vista. It replaces 

most of the non-Vista icons, animations and bitmaps 

that Microsoft is still overlooking. 

Vize automates the process of replacing resources in 

system files, applying the real fit and finish to Windows 

Vista. 

 

5.13.1 How Does Vize Work? 

The patching process will not disable Vista‟s built-in 

security features. Vize will automatically restore all 

files and folder permissions, making your Vista 

experience nicer without sacrificing security. 

Vize does not contain any spyware or ad-ware of any 

kind. 

If you are not satisfied with the results, you can 

completely uninstall Vize. 

http://www.vizeos.net/?page=downloads
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Vize is compatible with any version (except x64) and 

any language of Windows Vista and Windows Server 

2008. 
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6.0 Making the Most Out of 

Wallpaper and Screensavers 

 

 

 

ne of the easiest ways to add a personal touch to 

your computer is to change your wallpaper or 

your screensaver. If this concept is new to you, then 

this chapter is for you. If you are already familiar with 

changing your wallpaper and screensaver, you can skip 

the basic guides, which show you how, and you can 

explore the rest of this chapter. 

   In this chapter, you will learn how to change your 

wallpaper, how to make it more functional, and how to 

animate it. You’ll also learn how to change your 

screensaver and I’ll point you toward some good 

screensavers you can use on your computer. Finally, 

you’ll learn how to save your settings as a theme so 

you can reuse your customization settings anytime. 

O 
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6.1 Changing Your Desktop Wallpaper 

This simple guide will teach you how to change your 

wallpaper. If you are already familiar with this, please 

move on to the rest of this chapter to find out what 

else you can do with your wallpaper and screensavers. 

To change your desktop wallpaper, download one, and 

do the following: 

1. Right click the desktop and select Personalize 

2. Click Desktop Background 

3. Select the wallpaper picture or color you want, 

and specify its location: 

a. Windows Wallpapers to use one of the 

background patterns or pictures that came 

with Windows Vista 

b. Pictures, Sample Pictures, or Public 

Pictures to use a picture from one of those 

locations 

c. Solid Colors to use a single color 

d. Click Browse if you want to locate and use 

a picture from another location 

4. You can specify how your wallpaper will look: 

a. Stretched to fit the screen 

b. Repeated (tiled) across the screen 

http://mintywhite.com/tech/category/wallpaper/
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c. Or normal sized in the center of the screen 

with a solid colored background behind it 

Experiment and see what looks good on your 

computer. 

 

 

6.2 Making Your Wallpaper More 

Functional 

When you think of desktop wallpaper, you probably 

think of a way to express yourself with a picture you 

really like. You probably change your wallpaper often 

as your tastes change etc. One suggestion I have, is to 

make your desktop wallpaper more functional; thus, 

using it in a different way. 

We speak of the main screen of your computer as a 

desktop, but it doesn’t really look like a desktop. 

Download a desktop-like image here and organize your 

files accordingly – just like you would on a physical 

desktop. 

See Figure 6.2.1 for a sample of what the wallpaper 

looks like. 

http://flickr.com/photos/gr/182329409/sizes/o/in/set-72157594188036656/
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Figure 6.2.1 – ‘Desktop’ Desktop Wallpaper 

 

 

6.3 Animating Wallpaper with 

Dreamscene 

Unfortunately, Dreamscene only comes with Windows 

Vista Ultimate. There are ways to enable DreamScene 

on other versions of Vista, but this is not legal. If you 

do not have Vista Ultimate, please follow the next 

guide, which shows how you can get the same effect 

with VLC Player. 
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6.3.1 Installing Windows DreamScene 

To enable and use Vista DreamScene on your 

computer, do the following: 

Please note: As well as running Windows Vista 

Ultimate, you’ll also need Aero enabled. 

1. Press Start and select Control Panel 

2. In the search box, type 'update' and select 

'Windows Update' from the search results 

3. Click 'View available updates' in the upper right 

corner 

4. Under 'Windows Ultimate Extras', click on 'View 

available Extras' 

5. Select 'Windows DreamScene' and click 'Install' 

6. Restart your computer after DreamScene has 

finished installing 

7. Repeat steps 1-4 and download Windows 

DreamScene Content Packs 

8. Exit Windows update and right click on the 

desktop. You'll now have two options: 

 Pause DreamScene: This will pause a 

Windows DreamScene desktop background 

 Play DreamScene: This will un-pause the 

Dreamscene 
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6.3.2 Selecting a Dream 

To change your desktop background to a dream, do 

the following:  

1. Right click on a empty area of your desktop and 

click Personalize 

2. Select the 'Desktop Background' tab 

3. Click on the 'Location' drop down list and click 

on 'Windows DreamScene Content' 

4. Select a DreamScene (video) you want on your 

desktop background 

5. Press ‘OK’ 

 

 

6.4 Animating Wallpaper with VLC Player 

If you do not use Vista Ultimate, you can still animate 

your wallpaper, by using VLC Player – a free media 

player solution that is low on resource usage. To get 

animated wallpaper with VLC, do the following: 

1. Download the latest version of VLC Player 

2. Navigate to Settings > Preferences > Video > 

Output Modules > Direct X 

http://www.videolan.org/vlc/
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3. Check the 'Advanced Options' box in the bottom 

right-hand corner 

4. Check 'Enable Wallpaper Mode' 

5. Navigate to 'Playlist' in the left-hand navigation 

menu 

6. Select 'Repeat Current Item' 

7. Press 'Save' 

8. Open your video file 

9. Right click on the video and select 'Wallpaper' 

 

Download some good animated wallpaper here: 

microsoft.com 

winmatrix.com forums 

skytimelapse.com 

corbismotion.com 

 

 

 

 

http://www.microsoft.com/windows/windowsmedia/musicandvideo/hdvideo/contentshowcase.aspx
http://www.winmatrix.com/forums/index.php?showtopic=12200
http://www.skytimelapse.com/hidef/index.php
http://www.corbismotion.com/home_flash/Home.aspx


67 | V I S T A  C U S T O M I Z A T I O N  M A N U A L  

Wallpaper & Screensavers 

6.5 Making Your Desktop Wallpaper 

Ripple like Water 

Want to add some eye candy to your desktop? With 

Ripple, you can do this. To configure your desktop, do 

the following: 

1. Download ripple 

 

2. Extract the file and install it 

 

3. Start ripple from the start menu and enjoy 

[Click for image of ripple on my desktop (1.04 MB)] 

 

 

6.6 Choosing a Screensaver 

To change your screensaver, you can do the following: 

1. Right click the desktop and select Personalize 

2. Click Screen Saver 

3. Select a screensaver from the list (or see the next 

section to add new screensavers) 

4. Click Settings and specify the options you want 

for the screen saver 

You can also do the following from this screen: 

http://solo-dev.deviantart.com/art/Solo-s-Ripple-89185830
http://mintywhite.com/images/techtips/0806/21ripplewallpaper/ripple-wallpaper-00.png
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 Preview the screen saver in full-screen view 

 Specify the length of time you want your 

computer to be inactive before the screen saver 

starts 

 Require log on after you stop the screensaver 

running 

 

 

6.7 Recommended Screensavers 

With so many screensavers available, here is an 

offering of some of the best screensavers that are low 

on resource consumption. 

 

6.7.1 Photo/Video Slideshow Screensaver 

To use you’re photos and videos as a slide show, do 

the following: 

1. Right click the desktop and select Personalize 

2. Click Screen Saver 

3. Select Photos in the Screen Saver list 

4. Click Settings 
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a. Choose pictures from your Photo Gallery 

(limit by tags or ratings) 

b. OR choose pictures from a specific folder 

(click Browse to specify the folder) 

5. Select a theme for the display 

6. Select the speed at which you want the pictures 

to change 

7. Specify whether or not you want your pictures 

appear in random order 

8. Press Save and press OK 

 

6.7.2 Other Recommended Screensavers 

I have a collection of screensavers here that you can 

download and use. 

 

 

6.8 Saving Your Settings as a Theme 

When you are satisfied with the appearance of your 

windows desktop, you may save the settings as a 

theme. A theme incorporates the following settings: 

 Color and appearance choices 

 

http://mintywhite.com/tech/category/screensavers/
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 Color schemes 

 

 Sound schemes 

 

 Mouse pointer schemes 

 

 Advanced appearance settings 

 

 Screen saver choice 

These settings are all unique to your account, so 

things like screen resolution, which is a global setting, 

will need manual changing. 

To save your settings as a theme, do the following: 

1. Right click the desktop and select ‘Personalize’ 

2. Click Theme 

3. Click ‘Save As…’ and choose a name 

You may now restore these saved settings at anytime 

by using the same method as above. 
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6.9 Change the Taskbar to Any Color(s) 

You Want 

 

Want to have a colorful task bar in Vista? Achieving this 

effect is very simple. Simply paste a color bar over the 

top of your wallpaper and set the new image as 

wallpaper. Now when you are viewing the desktop in 

Vista (with Aero enabled) you can see a colorful effect 

on your task bar. 

To create a wallpaper to change the taskbar color, do 

the following: 

1. Open your wallpaper in Photoshop/Paint.Net etc 

 

2. Create a new layer with the bars provided below 

and align the bar to the bottom of the wallpaper 

 

3. Save the file and set it as your wallpaper 

 

4. Now, when you are viewing your desktop with 

Aero enabled, you will see a colorful bar 

I put together some Photoshop and Bitmap files you 

can use these as the top layer — or you can make your 

own. 
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Sample Files to Use to Create Rainbow Taskbar Effect 

Resolution (Width) PSD Files BMP Files 

1024 Download Download 

1152 Download Download 

1280 Download Download 

1600 Download Download 

 

http://mintywhite.com/images/techtips/0806/24taskbarcolor/psd1024.zip
http://mintywhite.com/images/techtips/0806/24taskbarcolor/bmp1024.zip
http://mintywhite.com/images/techtips/0806/24taskbarcolor/psd1152.zip
http://mintywhite.com/images/techtips/0806/24taskbarcolor/bmp1152.zip
http://mintywhite.com/images/techtips/0806/24taskbarcolor/psd1280.zip
http://mintywhite.com/images/techtips/0806/24taskbarcolor/bmp1280.zip
http://mintywhite.com/images/techtips/0806/24taskbarcolor/psd1600.zip
http://mintywhite.com/images/techtips/0806/24taskbarcolor/bmp1600.zip
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7.0 Customizing Windows 

Explorer 

 

 

 

indows Explorer is your main portal to all your 

files. You can greatly increase your efficiency by 

making some simple changes. You can also add a 

personal touch to your file structure by following this 

chapter. 

In this chapter, you’ll learn how to standardize the view 

of Windows Explorer, set up quickly accessible 

shortcuts, improve the way you select files, change 

your folder backgrounds, and customize your folder 

icons. 

 

 

 

W 
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7.1 Setting Views for all Folders 

Windows Vista does a pretty good job at analyzing the 

content of a folder to determine how it should display 

the files. 98% of the time I just want to see the details 

of the files and I don’t care for thumbnails, tags, 

ratings etc. If you are like me and want to simplify 

Windows Explorer’s view, do the following: 

1. Open and folder and customize it in a way that 

you want reflected across all your folders 

2. Within the folder, press the ALT key once and 

then select ‘View > Folder Options’ 

3. Click the ‘View’ tab and click ‘Apply to Folders’ 

4. When prompted, select ‘Yes’ and your settings 

will now be in effect. 

 

Please Note: Any previous customization may be 

retained for specific folders you’ve already worked with 

– but don’t count on it. 
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7.2 Setting up Shortcuts to Common 

Folders 

Windows Explorer has a great feature in Vista: the 

shortcut menu. This shortcut menu is customizable 

and can save you a lot of time if you frequently open 

and close files from specific locations. 

 

7.2.1 Adding Shortcuts to the Shortcut Menu 

To add a shortcut to the menu, do the following: 

1. Locate the folder you want to add 

2. Click on it and drag it to the menu 

 

7.2.2 Removing Shortcuts from the Shortcut Menu 

To remove a shortcut from the menu, do the following: 

1. Right click on the shortcut 

2. Click ‘Remove Link’ 
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7.3 Selecting Multiple Files with 

Checkboxes 

When you want to select multiple files, you need to 

hold the CTRL key; if you let go of it before selecting 

another file, you lose your entire selection. Windows 

Vista’s solution to this is allowing you to select check 

boxes next to files, so you do not have to hold the 

CTRL key. 

To enable check box file selection, do the following: 

1. Within the folder, press the ALT key once and 

then select ‘View > Folder Options’ 

2. Click the ‘View’ tab and under ‘Advanced 

settings’, locate and select ‘Use check boxes to 

select items’ 

Now you can check the files you want to collectively 

select. 

 

 

7.4 Changing Folder Backgrounds 

In Vista, the ability to have custom backgrounds in 

explorer folders is gone. Vista Folder Background 

makes folder backgrounds possible again. 

 

http://mpj.tomaatnet.nl/vista/folderbg.html
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7.4.1 About Vista Folder Background 

Vista Folder Background applies a background to any 

folder and automatically applies that same background 

to subfolders. 

 

7.4.2 Installing Vista Folder Background 

1. Download Vista Folder Background 

 

2. Unzip the downloaded file 

 

3. Run install.bat 

To uninstall, run uninstall.bat - then restart your 

computer 

 

 

7.5 Customizing Folder Icons 

I use some folders as a dashboard to get to commonly 

used folders. A good example of this is my ‘Media’ 

partition. Here, I have my Music, Video, Pictures, and 

other folders. In this guide, you’ll learn how to 

customize your folder icons to achieve something 

similar to Figure 7.5.1. 

http://mpj.tomaatnet.nl/vista/folderbg.html
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Figure 7.5.1 – Customized Folder Icons 

 

To change your folder icons, do the following: 

1. Right click on the folder you want to customize 

the icon for and select ‘Properties’ 

 

2. Select the ‘Customize’ tab and click on ‘Change 

Icon…’ 

 

3. Select an Icon or browse for your own (get 

thousands of icons here) 

 

4. Press ‘OK’ on both screens and you are done. 

http://mintywhite.com/tech/category/icons


V I S T A  C U S T O M I Z A T I O N  M A N U A L  | 80 

Windows Explorer 

Note: To view larger icons in Windows Explorer, click 

the ‘Views’ button, on the toolbar, until you get to 

large icons. 
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8.0 Organizing Your Files 

 

 

 

here are many ways to organize your files and an 

in-depth organization solution is out of the scope 

of this book; however, this chapter offers a few tips to 

help you keep on top of your files. 

In this chapter, you’ll learn how to automatically move 

files from your desktop, use naming conventions, 

batch rename your files, and relocate your personal 

document folders from the default locations set in 

Windows Vista. 

 

 

 

 

 

T 
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8.1 Automatically Moving Files from Your 

Desktop 

Do you have a cluttered desktop? Do you spend time 

looking for the documents, pictures etc you’ve saved 

recently and then move them to different folders? If 

this is the case, or if you just like a clean desktop, this 

guide is for you. Desktop teleporter is a great utility 

that moves files and folders that are newly created on 

your desktop to pre-determined folders. 

To automate the process of organizing your desktop, 

do the following: 

1. Download Desktop Teleporter 

 

2. Set up rules to help manage images, music, 

documents etc 

 

3. Set exceptions to your rules if you need them 

[Click to see an image of my clutter-free desktop] 

 

 

8.2 Use Naming Conventions to Organize 

Your Data 

Here you may see the naming conventions I use for my 

files. This is just as a guide to get you started on your 

own system. I set many of these conventions many 

http://tchikien.donationcoders.com/
http://mintywhite.com/images/techtips/0805/31desktopteleporter/desktop-full.png
http://mintywhite.com/tech/xp/use-naming-conventions-to-organize-your-data/
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years ago, but they work. Experience has given me 

newer ideas, some of which I am currently using. 

Photo Files 

I archive my photos in the following way:  

Photo > %Year% > %Date%&Title 

Documents 

Even though you can sort files by date in all popular 

OSs, I still append a date to the front of a file. This 

helps me with versioning and I usually remember when 

I wrote something, and not what I called it. 

Music 

Everyone names their music differently, this is my way 

(but I’m not an MP3 tag person, so I would probably 

use this for inspiration and not instruction.) 

I archive my music in the following way: 

Music > %genre% > %album_title% 

All individual songs that I buy separately go into the 

genre folder, along with any albums that are in their 

own folders. Tags essentially do the same thing, but 

when you have over 100 albums (or 1000s as may be 

the case), it helps to do some organization within your 

file structure. 

As a reminder, please visit this page, for screenshots of my 

file system. 

http://mintywhite.com/tech/xp/use-naming-conventions-to-organize-your-data/
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8.3 Batch Rename Your Files 

I don’t remember when I first started using D-File Mu, 

but it is an invaluable tool for me. I use it all the time 

and I recommend it to anyone. It may take a little 

getting used to, but it’s not too complicated and works 

very well. In this guide, you’ll learn how to set rules 

and batch rename your files without going near the 

command prompt. 

Download D-FileMU 

 

8.3.1 D-FileMU Features 

D-File MU Performs the following changes: 

 Adding strings to the beginning and end of the 

filenames  

 

 Deleting specified number of characters from 

beginning or end of the filenames  

 

 Adding numbers in sequence to the beginning or 

end of the filenames  

 

 Changing to upper or lowercase  

 

 Replacing strings with specified string  

 

 Changing the file extension of filenames  

 

 Capitalizing words and more…  

http://www.softpedia.com/get/System/File-Management/D-FileMU.shtml
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8.4 Relocating Personal Data Folders 

I don't like having my personal files on the system 

drive. If you get a virus or reinstall your operating 

system, you stand a higher chance of losing your files. 

I always keep my personal files on a separate partition 

or drive. Windows likes to store your saved videos, 

music, pictures etc in your Documents folder; in this 

guide, you'll learn how to relocate your personal 

folders. 

To relocate your personal files, do the following: 

1. Press the Start button 

2. Click your account name in the right-hand menu 

3. Right click a folder that you want to relocate and 

select Properties 

4. On the Location tab of the properties dialog box, 

enter the address that you want to relocate to 

5. Click OK 

Windows will ask permission to create the target folder 

if it doesn’t already exist, so click 'Yes'. I advise moving 

all the original files to the new location, unless you see 

a reason not to. 

The final step is to add your new personal folder 

locations to the search index. An explanation of how to 

do this is outside the scope of this book. 
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About This Book 

 

 

y name is Rich and I am the author and creator of 

Windows Guides on mintywhite.com. Web design 

is my hobby and I’ve been developing websites for over 

ten years – HTML, DHTML, XML, C#, J#, VB.NET, 

ASP.NET, ASP, Javascript, Java, PHP – you name it, I’ve 

probably developed in it at some time.  

   I enjoy the design aspect of web development, but 

I’m not that good at it (make your own judgment on 

that) However, I love putting together How To’s, 

documentation, tutorials, guides etc. and want to share 

that talent with you all.  

   There is no charge for this book – if you somehow 

paid for it, get a refund! I hope this guide can be a 

reference for you in the future as you customize 

Windows Vista.  

I also wrote Windows Vista – The Pocket Guide 

M 

http://mintywhite.com/tech/announcements/vista-pocket-guide/
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Contact Me 

 

 

ou may have questions as you read this book – 

please don’t keep them to yourself – ask me them 

anytime. There are a number of ways you can contact 

me – listed below: 

 Website: http://mintywhite.com  

 Email: rich@mintywhite.com  

 Digg: http://digg.com/users/mintywhite  

 Plurk: http://www.plurk.com/user/mintywhite  

 StumbleUpon: http://mintywhite.stumbleupon.com  

 Twitter: http://twitter.com/mintywhite  

 AIM: mintywhitecom 

 ICQ: 363425810 

 MSN: mintywhitecom@hotmail.com  

 Yahoo: mintywhitecom 

Y 

http://mintywhite.com/
mailto:rich@mintywhite.com
http://digg.com/users/mintywhite
http://www.plurk.com/user/mintywhite
http://mintywhite.stumbleupon.com/
http://twitter.com/mintywhite
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Version Date Revisions 

1.0 17 Aug 08 First edition published 

   

   

   

   

   

   

 

Get the latest version of the book here  

(Registration Required)

http://mintywhite.com/forum/viewtopic.php?f=25&t=243
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